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Copyright 
Copyright (C) 2005 PLANET Technology Corp. All rights reserved.  

The products and programs described in this User’s Manual are licensed products of PLANET 
Technology, This User’s Manual contains proprietary information protected by copyright, and 
this User’s Manual and all accompanying hardware, software, and documentation are copy-
righted.  

No part of this User’s Manual may be copied, photocopied, reproduced, translated, or reduced 
to any electronic medium or machine-readable form by any means by electronic or mechanical. 
Including photocopying, recording, or information storage and retrieval systems, for any purpose 
other than the purchaser's personal use, and without the prior express written permission of 
PLANET Technology. 

 
Disclaimer 
PLANET Technology does not warrant that the hardware will work properly in all environments 
and applications, and makes no warranty and representation, either implied or expressed, with 
respect to the quality, performance, merchantability, or fitness for a particular purpose. 

PLANET has made every effort to ensure that this User’s Manual is accurate; PLANET dis-
claims liability for any inaccuracies or omissions that may have occurred. 

Information in this User’s Manual is subject to change without notice and does not represent a 
commitment on the part of PLANET. PLANET assumes no responsibility for any inaccuracies 
that may be contained in this User’s Manual. PLANET makes no commitment to update or keep 
current the information in this User’s Manual, and reserves the right to make improvements to 
this User’s Manual and/or to the products described in this User’s Manual, at any time without 
notice. 

If you find information in this manual that is incorrect, misleading, or incomplete, we would 
appreciate your comments and suggestions. 

 
CE mark Warning 
The is a class B device, In a domestic environment, this product may cause radio interference, 
in which case the user may be required to take adequate measures. 

 

Trademarks 
The PLANET logo is a trademark of PLANET Technology. This documentation may refer to 
numerous hardware and software products by their trade names. In most, if not all cases, these 
designations are claimed as trademarks or registered trademarks by their respective companies. 

 

WEEE regulation 
To avoid the potential effects on the environment and human health as a result of 
the presence of hazardous substances in electrical and electronic equipment, end 
users of electrical and electronic equipment should understand the meaning of the 
crossed-out wheeled bin symbol. Do not dispose of WEEE as unsorted municipal 
waste and have to collect such WEEE separately. 
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Chapter 1 
Introduction 
 
The BT-410U/420U is designed to connect USB port of a desktop or laptop PC, and allows the 
computer to build a short-range wireless connection to other Bluetooth devices like cellular 
phones, PDAs, and computers. Since the transmission medium of BT-410U/420U is air, 
PLANET also enhances both connection protection and data security mechanism to the product 
which helps people share and access trigger information. Compliant with Bluetooth specification 
Version 2.0 + EDR, BT-410U/420U can provide transfer rate up to 3Mbps, which is higher than 
Bluetooth v1.2 device.  
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The BT-410U/420U provides services of virtual serial port, dial-up networking, fax, file transfer, 
information exchange, information synchronization, and network access. With powerful bundled 
software, it’s not difficult to implement configuration and management even there are so many 
functions. Most popular operating system support, including Windows 98SE, ME, 2000, XP and 
Server 2003, makes the application of BT-410U/420U more flexible. 
 
Link your notebook with your handheld, mobile phone, printer, audio gateway and 
other Bluetooth devices within your personal area network (PAN) via a secure short-
range wireless radio link. Get rid of all those hassle cables and automatically share 
documents, browse the Internet and synchronize calendars, address books and more. 

1.1 Features 

 Compatible with Bluetooth Core Specification Version 2.0 + EDR (Enhanced Data 
Rate) 

 Bluetooth Manager Utility eases the difficulties of configuration and management 

 Date rate up to 3Mbps  

 Lower power consumption through reduced duty cycle 

 Simplification of multi-link scenarios due to more available bandwidth 

 Backwards compatible to Bluetooth V1.1/V1.2 specifications 

 Further improved BER (Bit Error Rate) performance 

 Connection protection and data security enhanced mechanism 

 Up to 8 devices Point-to-MultiPoint topology expands your PAN coverage 

 Various services provided: Virtual Serial Port, Dial-up Networking, Fax, File Trans-
fer, Information Exchange, Information Synchronization, and Network Access 

 Multilingual support in Bluetooth utility 
 Most popular OS support: Windows 98SE/Me/2000/XP and Server 2003 
 BT-410U has suppor Bluetooth Class 1, it can provide bigger cover area for user to 

connect their Bluetooth device longer 
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1.2 Package Contents 

The following items should be included: 
• 1 * Bluetooth V2.0 USB Adapter 
• 1 * CD-ROM (includes Driver, Utility, Manual)  
• 1 * Quick Installation Guide  

If any of the above items are damaged or missing, please contact your dealer imme-
diately. 
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2 Chapter 2 
Installation 
2.1 Software Installation 

Note: The Bluetooth Software should be installed well prior to the hardware installa-
tion. If the hardware install to PC before software installed, Windows will install this 
Bluetooth device with its built-in driver. That will make the Bluetooth device work 
incorrect. 

1. Insert the CD-ROM into the CD-ROM drive to initiate the autorun program. Once 
completed, a menu screen will appear. 

2. To install the Bluetooth software, click on the "Bluetooth Software" hyperlink to 
activate the installation procedure for the application program. 
If the autorun program is not executed, you can start the installation as follows. 

• Click on Start Menu/ Run. 
• Enter “D:\Utility\setup.exe” in the appeared box, where “D” is the letter of your 

CD-ROM drive. 
• Click on “OK” button. 

3. On the Welcome screen, click the Next button. 

 
4. When the License Agreement screen is displayed, read the License Agreement, 

then select “I accept the terms in the license agreement” and click the Next but-
ton. 
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5. On the Destination Folder screen, click the Change button to browse to a new 

destination folder for the Bluetooth software. Otherwise, click the Next button to 
accept the default folder. 

 
6. The InstallShield Wizard is ready to install the Bluetooth software. If you need to 

review or change any settings, click the Back button. Click the Cancel button to 
exit the Wizard. Otherwise, click the Install button  
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7. In Windows 2000/XP/Server 2003, you may see the screen below, click OK at the 

following message. In Win98/Me, installation may ask you to insert Windows Re-
source CD. Please insert your Win98/Me CD and click Yes.  

 
8. This screen will prompt you the Bluetooth device is not found. Please press Can-

cel to continue.  

 
9. When finished, click Finish to end the Installation Wizard.  
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10. Please click Yes to restart your computer.  

 

2.2 Software Un-installation 

1. In Windows, go to Start →Settings→ Control Panel→ Add or Remove Programs.  

2. Select “PLANET Bluetooth Software” and click the “Remove” button.  
 

2.3 Hardware Installation 
 
Note: The hardware installation should be only performed after the software is 
well installed.  

Precaution 
Before the installation, make sure the USB port exists in your computer and is enabled. 
To check this, go to My Computer Control Panel System. Open the Device 
Manager tab. If the Universal Serial Bus controller device is found, it means your 
USB port is installed and enabled. If not, either no USB port is installed or the USB 
bios is not properly enabled. In this case, consult your computer dealer for USB sup-
port. 
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Procedures 
1. Please make sure you have see the bluetooth icon in the system tray like below. 

  
2. Plug your BT-410U/420U into the PC USB port.  

3. Windows will detect the device and ask the driver. Please select Install the 
software automatically (Recommended) and click Next.  

 
4. Please click Finish to completed driver installation. 
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5. When the driver installed. You will see the bluetooth icon turn into white like 

below.  

 

2.4 Initial Bluetooth Configuration 

Double click this icon  to make the initial Bluetooth configuration.  

1. The following message is shown to prompt you to select the location where you 
want to show the Bluetooth icon.  Select the location and click Next.  

 
2. On the Device Name and Type screen, enter the required information: 
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Computer Name—other Bluetooth-enabled devices, when inquiring about de-
vices within radio range, will see this user-configured device name. 

The name can be changed after the installation process through the Bluetooth 
Software Configuration Panel. 

Computer Type—click the down arrow and choose Desktop or Laptop from 
the drop-down list. The device type can be changed after the installation process 
through the Bluetooth Software Configuration Panel.  

Click the Next button. 

 
3. Click Next to configure the Bluetooth services that this computer will offer to the 

Bluetooth devices.  
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4. Select the services you want this computer to offer and click the Configure if you 
need further configuration.  Click Next to continue. 

 
5. The following message is shown. Please wait for a while for the software installa-

tion process to complete. 

 

 

6. After the service install to your PC, you may click Skip to finish the service instal-
lation or click Next and refer to step 7 to start search the Bluetooth device which 
you want to connect.  
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7. Please click Finish to complete the Bluetooth Configuration Wizard.  

 
8. After click Next in step 5, you will see this screen that will show you all the Blue-

tooth devices which you can find. If the device you want to connect is not display 
in this screen, please select what kind of device you want to find in the pull-down 
list and click “Search Again”. When the Bluetooth device is found, please click 
Next to connect to this device.  
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3 Chapter 3 
Bluetooth Software 
 

3.1 About Bluetooth Software 
The Bluetooth for Windows software consists of the following components: 
‧ Microsoft® Windows® Explorer Extensions—Provide access to Bluetooth 
devices in the immediate vicinity using Windows Explorer. 
‧ My Bluetooth Places—Graphical user interface (GUI) that provides access to 
Bluetooth devices in the immediate vicinity. Also provides access to configure the 
local devices and access to perform other Bluetooth tasks. 
‧ BTTray Security Manager—Controls and manages Bluetooth security levels. Also 
enables you to grant or deny access and to filter what can be accessed on a Bluetooth 
device. 
‧ Bluetooth for Windows Configuration Panel—Configures your Bluetooth for 
Windows (BTW) software using the Windows Control Panel. 
‧ Stack Server—Provides an interface for the operating system to control Bluetooth 
devices and to ensure that Bluetooth connections operate together correctly. The 
stack server has a built-in Security Manager that protects the Bluetooth device from 
unauthorized access. 
‧ Bluetooth Setup wizard—Facilitates the configuration and modification of your 
Bluetooth environment. The wizard can be used to configure or change local services 
or to establish connections to remote devices based on service type or device type. 
‧ Quick Connect—Facilitates fast connections based on service type. You are able 
to quickly find devices that support a particular service and establish a connection to 
that service. During this process, a shortcut to the service is created in My Bluetooth 
Places, which can be used for subsequent connections.  
3.2 Bluetooth Tray 
The Bluetooth tray resides in the Windows system tray, which is normally located in 
the lower-right corner of the screen. The Bluetooth tray provides fast access to most 
Bluetooth operations. 
From the Bluetooth tray you can: 
‧ Access My Bluetooth Places—double-click the Bluetooth icon, or right-click the 
Bluetooth icon and then select Explore My Bluetooth Places. 
‧ Access the Bluetooth Setup Wizard. This wizard will help you: 

 Configure how this computer accesses a service on another Bluetooth device 
 Locate remote Bluetooth devices 
 Configure the way that this computer provides services to remote Bluetooth 

devices 
 Set the name and type of this Bluetooth device, e.g., “John's PC” and “Desk-

top.” 
‧ Access the Bluetooth Configuration Panel—right-click the Bluetooth icon, and 
then select Advanced Configuration. 
‧ Access the Quick Connect option—right-click the Bluetooth icon, select Quick 
Connect, and then select the type of service to which you wish to connect. 
‧ Start/Stop Bluetooth on this computer 
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3.3 Access My Bluetooth Places 
My Bluetooth Places is part of Windows Explorer. 
There are multiple ways to access My Bluetooth Places: 
‧ In the Windows system tray 

  Right-click the Bluetooth icon and select Explore My Bluetooth Places 
or 
Double-click the Bluetooth icon 

‧ On the desktop, double-click the Bluetooth icon 
‧ Open Windows Explorer and select My Bluetooth Places in the Folders pane or 
from the Address shortcut menu. 
 
3.4 Icon Used For Bluetooth Devices And Services 
The Bluetooth icon in the Windows system tray provides feedback about Bluetooth 
status. 
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4 Chapter 4 
Basic Operation 
 

4.1 Start or Stop Bluetooth  
To start Bluetooth: in the Windows system tray, right-click the Bluetooth icon and 
select Start the Bluetooth Device. The Bluetooth icon is blue in color with a white 
insert when Bluetooth is running. 
To stop Bluetooth: in the Windows system tray, right-click the Bluetooth icon and 
select Stop the Bluetooth Device. The Bluetooth icon is blue in color with a red insert 
when Bluetooth is stopped. 

4.2 Create A Connection From The Bluetooth Icon In The 
System Tray  
In the Windows system tray, right-click the Bluetooth icon, select Quick Connect and 
then select the Bluetooth service that you wish to use. 
 
If this computer has created a connection to the desired type of service in the past, the 
options on the shortcut menu are: 
‧ The name(s) of any device(s) with which prior connections to this type of service 
have been established. Select a name from the list to re-establish connection. 
‧ Other Devices…Select this option to search for additional devices that potentially 
provide the desired service, select a device from the list, and then click Connect. 
 
If this computer has never created a connection to this type of service, the only option 
on the shortcut menu is “Find Devices….” Select this option to search for devices that 
potentially provide the desired service, select a device from the list, and then click 
Connect. 

4.3 Create A Connection Using The Bluetooth Setup Wiz-
ard  
‧ In Windows Explorer: 

Right-click My Bluetooth Places and select Bluetooth Setup Wizard 
or 
With My Bluetooth Places selected, from the Bluetooth menu, select Bluetooth 
Setup Wizard 
or 
With My Bluetooth Places selected, double-click Bluetooth Setup Wizard 
or 

‧ From the Windows system tray:  
Right-click the Bluetooth icon and select Bluetooth Setup Wizard.  

 
Follow the on-screen instructions. 

4.4 Create A Connection From Entire Bluetooth 
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Neighborhood  
From Windows Explorer: 

In the Folders pane, select Entire Bluetooth Neighborhood, right-click a device 
name and then select the preferred service from the list. 
‧ Connect Dial-Up Networking 
‧ Connect Bluetooth Serial Port 
‧ Connect Network Access 
‧ Connect Audio Gateway 

NOTE: Only available services are displayed in the menus. 
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Chapter 5 
Find Bluetooth Devices 
 
Search for Devices looks for Bluetooth devices in the vicinity and displays the de-
vices that it finds in My Bluetooth Places. 

5 
To start a search for devices, in the Folders pane of My Bluetooth Places, select 
Entire Bluetooth Neighborhood, and then, from the Bluetooth menu, select Search for 
Devices. 
NOTE: The Bluetooth menu is visible only when My Bluetooth Places is active. 

5.1 Periodic Search For Devices  
Bluetooth can be configured to search automatically for devices on a regular basis 
(Bluetooth Configuration Panel > Discovery tab). 
One of the advantages of Bluetooth is the mobility that the wireless connections allow. 
However, mobility means that devices may move in or out of connection range during 
the time between the automatic updates performed by Bluetooth. To be certain that 
the displayed list of devices in the neighborhood is current, or if automatic periodic 
inquiry is not enabled, force an update of the device list using the technique described 
in Search for Devices, above. 
Some devices within connection range may not show up in the list of devices 
found because: 

‧ Your device is configured to report only specific types or classes of devices 
(Bluetooth Configuration Panel > Discovery tab, on your device). 
‧ The unlisted device is configured to be non-discoverable. Refer to the unlisted 
device’s documentation for assistance in making that device discoverable. 

NOTE: If you enable the periodic search for devices feature you may experience 
some performance degradation while the search is in process, depending on the type 
of system you have. 

5.2 Find A Service  
The process of determining the services that a device provides is called Service 
Discovery. 
To initiate a Service Discovery, in the Folders pane of My Bluetooth Places, right-
click a device name and select Discover Available Services from the shortcut menu. 
Bluetooth services are those things that this computer can do for remote Bluetooth 
devices. For example, if this computer allows a remote Bluetooth device to send a fax 
using a fax modem that is physically attached to this computer, then this computer is 
providing the Bluetooth fax service. 
Some services are hardware dependant; this computer cannot provide the fax service 
unless it has a physical fax modem, for example. 
Some Bluetooth services use virtual “hardware.” The Bluetooth Serial Port service, for 
example, does not use a physical port on this computer. Instead, it creates virtual 
serial ports that Windows applications can see and use as if they were actual physical 
ports. 
Each Bluetooth service that this computer is capable of providing can be started 
automatically when Bluetooth starts. Each service can be setup to require security 
measures before allowing a remote Bluetooth device to connect. 
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Bluetooth services require a Bluetooth application on the remote device; services and 
applications usually have coinciding names; i.e., there is a Bluetooth Fax Service and 
a Bluetooth Fax Application. 
The services supported by Bluetooth are: 

‧ Bluetooth Imaging—allows a remote device to send images (BMP, GIF, PNG, & 
JPG) to this computer. Images are stored in the Bluetooth Exchange Folder. 
‧ Bluetooth Serial Port—a wireless connection between two devices. This con-
nection can be used by applications as though a physical serial cable connected 
the devices. 
‧ Dial-up Networking—allows a device to use a modem that is physically attached 
to another Bluetooth device. 
‧ Fax—allows a device to send a fax using a remote Bluetooth cell phone, mo-
dem, or computer. 
‧ File Transfer—allows a device to perform file system operations on another 
Bluetooth device; browse, open, copy, etc. 
‧ Headset—allows a Bluetooth headset to be used as the audio input/output 
mechanism for another Bluetooth device, such as a computer or cell phone. 
‧ PIM Item Transfer—allows two Bluetooth devices to exchange Personal Infor-
mation Manager data such as business cards, calendar items, email messages, 
and notes. 
‧ PIM Synchronization—allows two Bluetooth devices to synchronize Personal 
Information Manager data. 
‧ Network Access—allows a device to access a Local Area Network via a second 
Bluetooth device that is physically connected to the network or allows a remote de-
vice to become part of an ad hoc network provided by the Bluetooth server. 
‧ Audio Gateway—allows the microphone/speakers on a Bluetooth device (typi-
cally a computer) to be used as the audio input/output mechanism for a remote 
Bluetooth device, such as a cell phone. 

All Bluetooth servers do not necessarily provide all of these services. For example, 
network gateways may provide only the Network Access service. 

5.3 Bluetooth Connection Status  
The Bluetooth Connection Status dialog box displays information about the state of a 
connection and provides a means to disconnect an active connection. 
Display the Connection Status dialog box: in My Bluetooth Places, from the Fold-
ers pane, select a device, and then, in the right pane of My Bluetooth Places, right-
click a service name and select Status from the shortcut menu. 
The Information provided is: 

‧ Status: “Connected” or “Not Connected” 
‧ Device Name: the name of the device to which this computer is connected. 
‧ Duration: the length of time that this connection has been established, dis-
played in hours, minutes and seconds. Depending on the service, the connection 
may time out (automatically disconnect) after a specific period of inactivity. 
‧ Activity: the number of bytes sent and received over the connection. 
‧ Signal Strength: a graphic indicator that ranges from Too Weak through Good 
to Too Strong. 

NOTE: To change the power transmission level of this computer: from the Bluetooth 
Configuration Panel, Hardware tab, click the Advanced button, and then change the 
setting in the Maximum Power Transmission drop-down list. The Advanced button is 
not available in all countries. 
The controls in the Bluetooth Connection Status dialog box are 
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‧ Properties button: displays the Bluetooth Properties dialog box for this connec-
tion. 
‧ Disconnect button: closes this connection. 
‧ Close button: closes the Bluetooth Connection Status dialog box. 

5.4 Send To Bluetooth  
This feature is used to send information to another Bluetooth device. Data types 
include: 

‧ Files from Windows Explorer 
‧ Documents from Microsoft Office applications, including: 

  Word 
  Excel 
  Access 
  PowerPoint 

‧ Microsoft Outlook items, including: 
  Contacts 
  Appointments 
  Tasks 
  Messages 
  Notes 

‧ Microsoft Internet Explorer: 
  Entire web pages 
  Individual images 

To use Send to Bluetooth (except Internet Explorer, see below) 
1. In the application: 

a) Windows Explorer—select one or more files to be transferred. Folders cannot 
be transferred. 
b) Microsoft Office—only the document in the active window can be transferred. 
c) Microsoft Outlook—select one or more items to be transferred. 

2. From the File menu, select Send To, and then select Bluetooth from the shortcut 
menu. 
3. Select a device from the shortcut menu to send the data 

or 
Select Other..., choose a device from the list, and then click OK to send the data. 

Send via Bluetooth from Internet Explorer 
Send an entire web page: 

1. From the Tools menu, select Send To Bluetooth (or click the Bluetooth icon on 
the toolbar) 
2. In the Select Device dialog box, choose a device and then click OK. 

Send a selected image: 
1. Right-click the image to be transferred and select Send To Bluetooth from the 
popup menu. 
2. In the Select Device dialog box, choose a device and then click OK. 
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Chapter 6 
Configure Bluetooth 
 

6.1 Access The Bluetooth Configuration Panel 
The Bluetooth Configuration Panel provides access to settings for Bluetooth services, 
client applications, hardware, security, discovery, accessibility, default paths, event 
notification and other Bluetooth related items. 
To Open the Bluetooth Configuration Panel 

‧ From the Windows Control Panel, select Bluetooth Configuration 
or 
‧ In the Windows System Tray, right-click the Bluetooth icon, and select Ad-
vanced Configuration from the shortcut menu. 

6.2 Bluetooth Services VS. Bluetooth Applications 
Bluetooth Services are services that this computer provides to remote Bluetooth 
devices. The Bluetooth services on this computer are referred to collectively in the 
Bluetooth configuration panel as “Local Services”. 
Bluetooth Applications are software applications on this computer that allow this 
computer to use the Bluetooth services that are provided by remote devices. The 
Bluetooth applications on this computer are referred to collectively in the Bluetooth 
configuration panel as “Client Applications”. 
Bluetooth Services and Bluetooth Applications usually have coinciding names; e.g., 
there is a File Transfer service and a File Transfer client application. 
How this computer provides a service to remote devices is configured on the Local 
Services tab of the Bluetooth configuration panel. 
How this computer uses a service that is provided by a remote device is configured on 
the Client Applications tab of the Bluetooth configuration panel. 

6.3 Bluetooth Exchange Folder 
This is the highest-level directory on this computer to which a remote Bluetooth device 
has access. 
Devices that have been granted access to the Bluetooth Exchange Folder on the 
computer also have access to all sub-folders contained within that folder and all files 
in those subfolders. 
NOTE: The Bluetooth Exchange Folder is shared by the PIM Item Transfer and the 
File Transfer services and can be configured from the Properties page of either of 
those services. When the Bluetooth Exchange Folder is re-configured for either of 
these services, the other service will be updated to use the new location. 

6.4 General Configuration Settings 
The settings on the General tab of the Bluetooth Configuration Panel determine i
mation that is displayed to remote devices. 

nfor-

6 
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Identity 

‧ Computer Name-enter a unique name to identify this computer to other Blue-
tooth devices in the vicinity; this field cannot be left blank. 
‧ Computer type-select either Desktop or Laptop from the shortcut menu to set 
the type of icon remote devices will use to represent this computer. 

6.5 Bluetooth Applications 

6.5.1 Overview 
Some built-in Bluetooth applications provide full functionality for a specific task, such 
as locating other Bluetooth devices or synchronizing two Personal Information Man-
agers. 
Other built-in Bluetooth applications provide a way for standard Windows applications 
to accomplish their tasks wirelessly. For example, a Bluetooth application may create 
a wireless serial connection between computers or provide wireless access to the 
Internet. 
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The difference between Bluetooth Applications and Bluetooth Services 

‧ Bluetooth Applications are software programs on this computer that allow this 
computer to use the Bluetooth services that are provided by other devices. In the 
Bluetooth configuration panel, these programs are referred to collectively as “Client 
Applications.” 
‧ Bluetooth Services are software programs on this computer that provide a ser-
vice to other devices. In the Bluetooth configuration panel, these programs are 
referred to collectively as “Local Services.” 

NOTE: Client Applications and Local Services usually have coinciding names; e.g., 
there is a Fax service and a Fax application. 
 
6.5.2 General Configuration 
All of the built-in Bluetooth applications allow you to rename the application and to 
require a secure connection when using the application. 
To access the configuration properties page for a built-in Bluetooth application 

‧ In the Windows system tray, right-click the Bluetooth icon and select Advanced 
Configuration from the shortcut menu 
or 
‧ From the Windows control panel select Bluetooth Configuration 
or 
‧ From Windows Explorer, right-click Entire Bluetooth Neighborhood and select 
Properties from the shortcut menu. 

In the Bluetooth configuration panel, Client Applications tab, highlight the application 
to be configured, and then click Properties (or double-click the application). 
 
6.5.3 Human Interface Device 
Overview 
The Human Interface Device (HID) Application allows this computer to wirelessly use 
one or more remote Bluetooth HIDs as input/output devices. 
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For example, the HID Application allows this computer to use a Bluetooth keyboard 
and a Bluetooth mouse. 
Create a Bluetooth HID connection 
NOTE: Some HIDs have multiple modes. Before establishing a connection, be sure 
the HID is in the appropriate mode. For example, in the case of an HID that can func-
tion as both a mouse and a laser pointer, be sure the mode switch is set to “Mouse” 
before attempting to connect. 
Open a connection to a Bluetooth Human Interface Device using one of these tech-
niques: 

‧ From My Bluetooth Places 
‧ Using the Bluetooth Setup Wizard 

Once an HID connection is established, that connection will persist. If the computer is 
shut down, when the computer is turned on again the connection will re-establish 
automatically. 
NOTE: HIDs usually have a button, which is sometimes difficult to find, that must be 
pressed before other Bluetooth devices can locate the HID. Even after the button is 
pressed, the HID can be discovered only for a limited time, and then the button must 
be pressed again. The time period can be as short as 30 seconds or as long as 180 
seconds. Read the documentation that accompanies the HID before you attempt to 
connect to the device. 
Close an HID connection 
Under normal circumstances, there is no reason to close an HID connection; once 
established the connection is maintained automatically, even during the power off and 
power on processes. 
If, for some reason, the connection must be closed: from My Bluetooth Places, right-
click the service name, and from the shortcut menu, select Disable. 
When an HID connection is closed manually by the operator, the connection’s “persis-
tence” is broken. The connection must be re-established manually, after which the 
connection will again persist until broken manually. 
Configure 
No configuration is necessary. 
 
6.5.4 Audio Gateway 
Overview 
The Audio Gateway Application allows a remote Bluetooth device to use this com-
puter’s microphone and speakers as the remote device’s audio input and output 
devices. 
Create a Bluetooth Audio Gateway connection 
Open a connection to the Audio Gateway service that is provided by another Blue-
tooth device using one of these techniques: 

‧ Windows system tray, Bluetooth icon 
‧ From My Bluetooth Places 
‧ Using the Bluetooth Setup Wizard 

Close an audio gateway connection: 
If the connection was established from the Bluetooth icon in the Windows system tray; 
click the Bluetooth icon, select Quick Connect, Audio Gateway and then select the 
device that is providing the service (active connections have a checkmark in front of 
them). 
or 
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No matter how the connection was created, in My Bluetooth Places, right-click the 
service name and select Disconnect. 
Configure 
The Bluetooth Configuration Panel > Client Applications > Audio Gateway > General 
tab provides options to configure: 

‧ The application name - to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, select the 
check box. 

 
6.5.5 Bluetooth Serial Port 
Overview 
The Bluetooth Serial Port application allows this computer to establish a wireless 
serial connection with a remote Bluetooth device. 
The applications on both this computer and the remote device must be configured to 
send and receive data to and from the respective communications port (COM port) 
assigned to the Bluetooth serial port. The wireless serial connection may then be used 
by the applications as though a physical serial cable connected the devices. 
Create a Bluetooth Serial Port connection 
Establish a connection using one of these techniques 

‧ Windows system tray, Bluetooth icon 
‧ From My Bluetooth Places 
‧ Using the Bluetooth Setup Wizard 

Close a Bluetooth Serial Port connection 
‧ If the connection was established from the Bluetooth icon in the Windows sys-
tem tray; click the Bluetooth icon, select Quick Connect, Bluetooth Serial Port and 
then select the device that is providing the service (active connections have a 
checkmark in front of them). 
or 
‧ No matter how the connection was created, In My Bluetooth Places, right-click 
the service name and select Disconnect. 

Configure 
The Bluetooth Configuration Panel > Client Applications > Bluetooth Serial Port > 
General tab provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 
‧ The communications port (COM port) to be used. 

NOTE: Unless you have a specific reason to do so, DO NOT CHANGE the default 
COM Port setting. 
 
6.5.6 Dial-up Networking 
Overview 
The Bluetooth Dial-up Networking application allows this computer to use a modem 
that is physically connected to a remote device to access the Internet, log on to a 
remote network. 
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Open a connection to the Dial-up Networking service that is provided by another 
Bluetooth device using one of these techniques: 

‧ Windows system tray, Bluetooth icon 
‧ From My Bluetooth Places 
‧ Using the Bluetooth Setup Wizard 

After the Bluetooth dial-up networking connection is established it can be used the 
same way as any other networking connection. For example, you can open a browser 
and explore the World Wide Web, if the remote computer has Internet access. 
Close a Dial-up Networking connection 

‧ In My Bluetooth Places, right-click the service name and select Disconnect 
or 
‧ If the connection was established from the Bluetooth icon in the Windows sys-
tem tray; click the Bluetooth icon, select Quick Connect, Dial-up Networking and 
then select the device that is providing the service (active connections have a 
checkmark in front of them). 

Configure 
The Bluetooth Configuration Panel > Client Applications > Dial-up Networking > 
General tab provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 
‧ The Bluetooth virtual device to be used. 

NOTE: Unless you have a specific reason to do so, DO NOT CHANGE the default 
Bluetooth device or alter the device's configuration. 
 
6.5.7 Fax 
Overview 
The Bluetooth Fax service allows this computer to send a fax using a Fax/Modem that 
is physically connected to a remote device. 
To Send a Fax 

1. Open a connection to the Fax service that is provided by another Bluetooth de-
vice, using one of these techniques: 

  Windows system tray, Bluetooth icon 
  From My Bluetooth Places 
  Using the Bluetooth Setup Wizard 

2. Open or create the document to be faxed and select the “Print,” “Send to Fax 
Recipient” or similar command that is available in most applications. 

Close a Fax Connection 
Fax connections close automatically when the Fax transmission is complete. 
Configure 
The Bluetooth Configuration Panel > Client Applications > Fax > General tab provides 
options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 

 
6.5.8 Headset 
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Overview 
The Headset application allows this computer to use a Bluetooth headset (or any 
other device that offers the Bluetooth headset service) as the audio input and output 
device for this computer. 
Possible uses include: 

‧ If this computer has on-board telephone hardware, a Bluetooth headset might 
be used as the audio input/output device to make/receive telephone calls. 
‧ If this computer has voice recognition capabilities, a Bluetooth headset might be 
used as the audio input device. 

Any other scenario that requires audio input/output can potentially take advantage of a 
Bluetooth headset to replace a hardwired microphone and/or speakers. 
Create a Headset connection 
Establish a connection using one of these techniques: 

‧ Windows system tray, Bluetooth icon 
‧ From My Bluetooth Places 
‧ Using the Bluetooth Setup Wizard 

NOTE: Most Bluetooth headsets “ring” when a connection is attempted; answer the 
ring to complete the connection and begin using the headset as the audio input/output 
device for this computer. 
Close a Headset connection 

‧ In My Bluetooth Places, right-click the service name and select Disconnect. 
or 
‧ If the connection was established from the Bluetooth icon in the Windows sys-
tem tray; click the Bluetooth icon, select Quick Connect, Headset and then select 
the device that is providing the service (active connections have a checkmark in 
front of them) 

Configure 
The Bluetooth Configuration Panel > Client Applications > Headset > General tab 
provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 

 
6.5.9 File Transfer 
Overview 
The Bluetooth File Transfer application allows this computer to perform file operations 
on the Bluetooth Exchange Folder (and the folders and files it contains) of a remote 
device. 
Copy to/from a remote device 
1. In the Folders pane of Windows Explorer, from the Entire Bluetooth Neighborhood 
branch, select a device and expand that branch to view the Bluetooth Exchange 
Folder of the remote device. 
NOTE: If “Public Folder” is not available, the remote device is not configured to allow 
remote file operations. 
2. Use drag-and-drop to copy any file or folder contained in the Public Folder of the 
remote device to the desired folder on this computer. You can also drag-and-drop files 
or folders from this computer to the Public Folder (and its sub-folders) of the remote 
device. 
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Other file operations 
Right-click a file or folder in the remote device’s Public Folder for a context sensitive 
menu. All potential menu options may not be available at all times. 
Potential menu options include: 

‧ Open—opens the selected file on this computer, using the default application for 
this type of file. 
‧ Print—sends the selected file to this computer’s default printer. 
‧ Send To 

  3 ½ floppy (A)—sends the selected file to the 3 ½ inch floppy drive on this 
computer 
  Bluetooth Exchange Folder—sends the selected file to the Bluetooth Ex-
change Folder on this computer. 

‧ Rename—applies only to empty folders; file names and the names of folders 
that contain objects cannot be changed using this technique. 
‧ Cut, Copy, Paste, Delete, Refresh, View & New—standard Windows functions. 

Configure 
The Bluetooth Configuration Panel > Client Applications > File Transfer > General tab 
provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 

 
6.5.10 Network Access 
Overview 
The Bluetooth Network Access application makes it possible for this computer: 

‧ To connect to a Local Area Network from a physical connection on a remote 
Bluetooth device. 
or 
‧ To connect to an ad hoc network provided by a remote Bluetooth device. When 
joining an ad hoc network, it can take up to one minute after the connection is es-
tablished to obtain an IP address and automatically self-configure. 

The type of network connection that is available is determined by the configuration of 
the remote Bluetooth device. 
Create a Network Access connection 
Establish a connection using one of these techniques 

‧ Windows system tray, Bluetooth icon 
‧ From My Bluetooth Places 
‧ Using the Bluetooth Setup Wizard 

Close a Network Access connection 
‧ In My Bluetooth Places, right-click the service name and select Disconnect. 
or 
‧ If the connection was established from the Bluetooth icon in the Windows sys-
tem tray; click the Bluetooth icon, select Quick Connect, Network Access and then 
select the device that is providing the service (active connections have a check-
mark in front of them). 

Configure 
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The Bluetooth Configuration Panel > Client Applications > Network Access > General 
tab provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 

 
6.5.11 PIM Synchronization 
Overview 
The PIM Synchronization Application is used to synchronize the Personal Information 
Manager (PIM) database of this computer with the PIM database of a remote Blue-
tooth device. 
The supported PIMs are: 

‧ Microsoft Outlook 
‧ Microsoft Outlook Express 
‧ Lotus Notes. 

The supported data types are: 
‧ Business cards 
‧ Calendar items 
‧ Email (with or without attachments) 
‧ Notes. 

Configure PIM Synchronization 
The Bluetooth Configuration Panel > Client Applications > PIM Synchronization > 
General tab provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 
‧ The PIM items to be synchronized and the PIM on this computer with which 
those items should be synced. 

NOTE: If synchronization is enabled for a specific item type, but is not enabled for that 
item type on the remote device, synchronization WILL NOT take place for that item. 

‧ The data item types which can be synchronized are: 
  Business cards 
  Calendar items 
  Email (with or without attachments-see below) 
  Notes 
Possible synchronization options for each of these data item types include: 

Do Not Synchronize-this item type will not be synchronized 
Synchronize Microsoft Outlook-this item type will be synced with its match-
ing entry in Microsoft Outlook, regardless of the PIM that contains this entry 
on the remote device. If a matching Outlook entry does not exist, it will be cre-
ated 
Synchronize Outlook-Express-this item type will be synced with its matching 
entry in Express, regardless of the PIM that contains this entry on the remote 
device. If a matching Express entry does not exist, it will be created 
Synchronize Lotus Notes-this item type will be synced with its matching en-
try in Lotus Notes, regardless of the PIM that contains this entry on the remote 
device. If a matching Notes entry does not exist, it will be created. 
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NOTE: Not all choices are available for all items. For example, “Note” items can be 
synchronized only in Microsoft Outlook. Therefore Lotus Notes and Outlook Express 
are not displayed as options in the “Notes” item shortcut menu. Personal Information 
Managers that are not installed on this computer are not displayed as options in the 
shortcut menus. 

‧ Email attachments. The only option is to include or not to include attachments 
with email that is sent or received on this computer using this service. 

 
6.5.12 PIM Item Transfer 
Overview 
The Bluetooth PIM Item Transfer application allows this computer to send and receive 
Personal Information Manager items to and from a remote Bluetooth device. 
The supported items are: 

‧ Business cards (*.vcf or *.vcd) 
‧ Notes (*.vnt) 
‧ Email (*.vmg) 
‧ Calendar (*.vcs) 

Item transfer can be accomplished several ways: 
‧ From Windows Explorer, My Bluetooth Places, highlight the PIM Item Transfer 
service on a remote device, and then, from the Bluetooth menu on the Windows 
menu bar, select the appropriate action. 
‧ From within a supported Personal Information Manager: 

Select one or more items and then, from the PIM's File menu, select Send to 
Bluetooth. 
or 
Drag-and-drop a supported item directly from your PIM to the PIM Item Transfer 
service icon of a remote device. 

‧ For business cards: 
From Windows Explorer, My Bluetooth Places, right-click the PIM Item Transfer 
service on a remote device and select the appropriate option. 
or 
In the Windows system tray, right-click the Bluetooth icon, select Quick Connect 
> Business Card Exchange, select a device from the list, select the appropriate 
option from the shortcut menu, and then click OK. 

Whether sent items are accepted by the remote device is determined by how the 
remote device's PIM Item Transfer service is configured. 
Close a PIM Item Transfer Connection 
This application closes the open connection automatically when its task is complete. 
Configure PIM Item Transfer 
The Bluetooth Configuration Panel > Client Applications > PIM Item Transfer > Gen-
eral tab provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 
‧ How your business card is handled when it is requested by a remote device. 
The Send My Business Card options are: 

Choose a business card as needed-each time a remote device requests your 
business card you must select a card from your PIM. If you ignore the request 
the remote device will receive a timeout notice. 
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Always send the same business card-when this option is selected a dialog box 
is displayed that allows you to set a default business card that will be sent auto-
matically when requests are received. 

‧ Where to store received business cards. The Received Business Cards options 
are: 

Microsoft Outlook 
Outlook Express 
Lotus Notes 

NOTE: The selected Received Business Cards option does not influence the settings 
on other PIM-related property pages. For example, even if the PIM Item Transfer 
service business card option on this computer is configured to “Do Not Accept,” the 
PIM Item Transfer application will still accept business cards that the application has 
specifically requested from its “Receive” or “Exchange” functions. 

‧ Email attachments. The only option is to include or not to include attachments 
with email that is sent or received on the computer using this service. 

 
6.5.13 Printer 
Overview 
The Bluetooth Printer application allows this computer to use a Bluetooth printer. 
Once a Bluetooth printer has been properly installed, it can be used from this com-
puter in the same way as any other printer would be. 
Configure 
The Bluetooth Configuration Panel > Client Applications > Printer > General tab 
provides options to configure: 

‧ The application name—to change it, highlight the existing name and enter the 
new name. 
‧ Enable or disable secure connection. To enable secure connection, place a 
checkmark in the box. 

Install a Bluetooth Printer 
Option One: 

1. Perform a search for devices and then, from Entire Bluetooth Neighborhood, 
right-click a Bluetooth printer, select Add Printer from the shortcut menu and follow 
the on-screen instructions. 
2. Select the printer make and model at the prompt. If your printer is not in the list 
of options, click Have Disk…, insert the driver disk for the printer, and then navi-
gate to the drive and directory that contains the driver initiation file (*.inf) for the 
printer. 
3. Follow the on-screen instructions to complete the installation. 

Option Two: 
1. From the Windows Control Panel, select Printers > Add Printer > Next > Local 
printer > Next. 
2. On the Select the Printer Port screen of the wizard: 

a) Select Create a new port. 
b) In the Type shortcut menu, select Bluetooth Printer Port, and then click Next. 

3. On the next screen, select the printer by name, and then click Connect. 
4. Install the driver: Select the printer make and model at the prompt. If your printer 
is not in the list of options, click Have Disk…, insert the driver disk for the printer, 
and then navigate to the drive and directory that contain the driver initiation file 
(*.inf) for the printer. 
5. Follow the on-screen instructions to complete the installation. 
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Delete a printer: 
Click Start > Settings > Printers, right-click the printer to be deleted, and then select 
Delete from the shortcut menu. 
or 
In Entire Bluetooth Neighborhood, right-click an installed Bluetooth printer and select 
Delete Printer from the shortcut menu. 

6.6 Bluetooth Services 
Common Configuration Settings 
These properties can be set individually for each Bluetooth service: 

 
‧ Service Name-the default name of each service can be changed. 
‧ Secure Connection-requires that remote devices provide proof of identity and 
that all data be encrypted. 
‧ Startup Automatically-starts the service automatically when Bluetooth is 
started. 
‧ Notifications-provides visual and/or audio notification that a remote device is 
attempting to connect (or has connected) to a service on this computer. 
 

6.6.1 Notifications 
Overview 
There are three types of notification: 

‧ Authentication request, also called a PIN code request—this notification is dis-
played automatically in a balloon over the Windows system tray if a Personal 
Identification Code is required before a connection can proceed. An audio file can 
also be associated with the notification. 
‧ Authorization request, also called a connection request—this type of notification 
can be visual, audio, or both. It notifies you of attempts to access a Bluetooth ser-
vice on this computer; the connection will not proceed until you click the balloon 
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that is displayed over the Windows system tray. If the notification balloon is ignored, 
the connection request will time out and fail. 
‧ Notification only—this type of notification does not affect access in any way; it is 
solely for information purposes to let you know that a connection has been estab-
lished. 

Example 
Both Authentication and Authorization request notifications are controlled by whether 
Secure Connection is enabled for an individual service. 
An example of how notifications might work when a remote device attempts to access 
a service on this computer, if all notifications are enabled: 

1. Authentication: a balloon notification (audio optional) prompts you for a PIN code. 
If the PIN code does not match the code entered on the remote device, the con-
nection will not be allowed. Once the remote device has been authenticated this 
notification will not appear again, unless the paired relationship is broken. If the 
paired relationship is broken, the devices must re-pair. 
2. Authorization: a balloon notification is displayed and/or a sound file provides au-
dio notification that a remote device is attempting to access a Bluetooth service on 
this computer. Click the balloon to proceed. A dialog box prompts you to enable 
the connection only once, or to allow this device to use the service every time. 
3. Once a connection has been authorized, an additional visual and/or audio notifi-
cation may be displayed (if enabled). This notification is for information only to 
inform the operator that a connection has been established. 

After two devices are paired (step 1, above), the authentication notification will no 
longer be displayed when a connection is attempted. 
If “Always allow…” is enabled during the authorization process (step 2, above), the 
authorization notification will not be displayed on future connection attempts. 
Connection notification (step 3, above) only happens if it has been enabled on the 
Notifications tab of the individual service being accessed. 
Service Access Notification 
“Notifications” lets you associate a sound (Windows *.wav file) and/or a visual indica-
tion with access attempts by remote devices. 
A different notification sound can be associated with each local Bluetooth service. 
Associate a sound with service access 
From the Bluetooth Configuration Panel, Local Services tab: 

1. Double-click a service name and then select the Notifications tab. 
2. Check the options you want; both visual and sound notifications may be se-
lected for a single event. 
3. Choose a sound; click the Browse button and navigate to the sound file (*.wav) 
to be used for notification. To preview the sound file, click the play button. 
4. Click OK to close the service's property dialog box. 

 
6.6.2 Audio Gateway 
The Bluetooth Audio Gateway service enables the computer to use the microphone 
and speakers on a remote Bluetooth device as the input and output devices for the 
computer. 
For example, if this computer has voice recognition capabilities, a Bluetooth headset 
might be used as the audio input device. 
Hardware Requirements 

‧ The Bluetooth hardware on this computer and on the remote device must sup-
port audio. 
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‧ The remote device handles both audio input and output for this computer; there-
fore, this computer does not require a sound card, microphone, or speakers. 

Configure the Audio Gateway Service 
From the Windows system tray, right-click the Bluetooth icon, select Advanced Con-
figuration > Local Services, and then double-click the Audio Gateway service. Set the 
common configuration properties of the service, and then click OK. 
 
6.6.3 Bluetooth Serial Port 
The Bluetooth Serial Port service enables a remote Bluetooth device to establish a 
wireless serial connection with this computer. The wireless serial connection may be 
used by applications as though a physical serial cable connected the devices. 
To establish a Bluetooth Serial Port connection 
The connection must be initiated from the remote device by the Bluetooth Serial Port 
application. 
Determine the communications port being used by this computer for the 
Bluetooth Serial Port 
In the Windows system tray, right-click the Bluetooth icon, select Advanced Configura-
tion, and then select the Local Services tab. The COM port assigned to this service is 
the last item in the Bluetooth Serial Port service row. Configure the application on this 
computer that will use this service to send its data to this COM. 
Add a Bluetooth Serial Port 
The Bluetooth Serial Port service has one pre-configured Bluetooth Serial Port, but 
additional Bluetooth Serial Ports can be added as needed. 
To add a port 

1. From the Bluetooth Configuration Panel, Local Services tab, click Add Serial 
Service. 
2. In the properties dialog box, modify the properties: 
3. Enter a unique name (fewer than 99 alphanumeric characters). 
4. Select secure connection, if you want. 
5. Select Startup Automatically, if you want 
6. From the COM Port shortcut menu select a communications port that is not as-
signed to any other service. 
7. Click OK. 

To remove a Bluetooth Serial Port 
From the Bluetooth Configuration Panel, Local Services tab, select the port to be 
removed and then click Delete. 
NOTE: The Delete button is only available when a Bluetooth Serial Port is selected. 
 

6.6.4 Dial-up Networking Service 
The Bluetooth Dial-up Networking service makes it possible for a remote Bluetooth 
device to use a modem that is physically connected to this computer. The remote 
device can then access the Internet or log on to a remote network. 
Configure the Dial-up Networking service: 
From the Windows system tray, right-click the Bluetooth icon, select Advanced Con-
figuration > Local Services, and then double-click the Dial-up Networking service. 

‧ Select the physical modem to be used from the Modems: shortcut menu. 
‧ Set the common configuration properties of the service, and then click OK. 
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6.6.5 Fax Service 
The Fax service allows a remote Bluetooth device to send a Fax via a modem that is 
physically attached to this computer. 
Configure the Fax service: 
From the Windows system tray, right-click the Bluetooth icon, select Advanced Con-
figuration > Local Services, and then double-click the Fax service. 

‧ Select the physical modem to be used from the Modems: shortcut menu. 
‧ Set the common configuration properties of the service, and then click OK. 

 

6.6.6 File Transfer Service 
Overview 
The File Transfer service allows this computer to perform file operations on the Blue-
tooth Exchange Folder (and the folders and files it contains) of a remote device. 
To use the File Transfer Service: 

1. Right-click the Bluetooth icon and select Explore My Bluetooth Places. 
2. Configure Windows Explorer so that the Folders pane is visible (View > Explorer 
Bar > Folders). 
3. In the Folders pane, select Entire Bluetooth Neighborhood 
4. On the menu bar, select Bluetooth > Search For Devices. 
5. In the Folders pane, expand Entire Bluetooth Neighborhood to show the devices 
in the vicinity. 
6. Select a device and expand that branch to view the Bluetooth Exchange Folder 
of the remote device. 

NOTE: If “Public Folder” is not available, the remote device is not configured to allow 
remote file operations. 
 
Use drag-and-drop to copy any file or folder contained in the Public Folder of the 
remote device to a folder on this computer. 
You can also drag-and-drop files or folders from this computer to the Public Folder 
(and its sub-folders) of the remote device. 
Other file operations 
Right-click a file or folder in the remote device’s Public Folder for a context sensitive 
menu. All potential menu options may not be available at all times. 
Potential menu options include: 

‧ Open—opens the selected file on this computer, using the default application for 
this type of file. 
‧ Print—sends the selected file to this computer’s default printer. 
‧ Send To 

  3 ½ floppy (A)—sends the selected file to the 3 ½ inch floppy drive on this 
computer 
  Public Folder on My Device—sends the selected file to the Public Folder on 
this computer. 

‧ Rename—applies only to empty folders; file names and the names of folders 
that contain objects cannot be changed using this technique. 
‧ Cut, Copy, Paste, Delete, Refresh, View & New—standard Windows functions. 

 

6.6.7 Headset Service 
The Bluetooth Headset Service allows this computer to provide audio input/output for 
remote Bluetooth devices. 
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For example, if the remote device is a Bluetooth telephone, this computer’s micro-
phone and speakers can be used as speakerphone input and output for that device. 
Hardware Requirements 

‧ This computer must have a sound card, microphone, and speakers installed. 
‧ The Bluetooth hardware on this computer and on the remote device must sup-
port audio. 

Configure the Headset Service 
‧ From the Windows system tray, right-click the Bluetooth icon, select Advanced 
Configuration > Local Services, and then double-click the Headset service. 
‧ Set the common configuration properties of the service, and then click OK. 

Usage Example with a Bluetooth Telephone 
From the Bluetooth phone, search for devices that offer the Headset Service, select 
the Headset Service on this computer, and then select Connect. 
NOTE: Individual Bluetooth phone manufacturers may use different terminology to 
describe the Headset Service, but the word “audio” and/or “headset” should be in the 
description— refer to the documentation included with the Bluetooth phone for assis-
tance. 
If the Headset Service has Secure Connection enabled, a PIN code and Authorization 
will be required to complete the connection. 
When the phone successfully connects to the Headset Service: 

‧ In the Windows system tray, the Bluetooth icon will be a blue field with a green 
insert (if another Bluetooth connection existed before this connection was estab-
lished, the icon would have already been this color). 
‧ A notification balloon will appear briefly above the Bluetooth icon with a mes-
sage similar to: 
Bluetooth Connection Successful 
Bluetooth device My Bluetooth Cell Phone is connected to the ‘Headset’ service on 
this computer. 

The Headset Service now monitors the phone and displays a notification balloon over 
the Bluetooth icon in the Windows system tray when an incoming call is detected. 
Click the balloon to acknowledge the notification, and then, in the Incoming Call dialog 
box, click the Accept button to accept the call. 
The audio signal from the phone is re-routed to the audio output device (speakers or 
earphones) on the computer, and the microphone on the computer provides the audio 
input for the phone. 
To reject the incoming call, when the Incoming Call dialog box is displayed, click the 
Reject button. 
 

6.6.8 Network Access 
The Bluetooth Network Access service enables a remote Bluetooth device to access a 
Local Area Network that is physically attached to this computer or allows a remote 
device to become part of an ad hoc network provided by this computer. 
After this computer has been configured to provide the Network Access service to 
other Bluetooth devices, it will not be able to use the Bluetooth Network Access ser-
vice provided by another Bluetooth device without being re-configured. In other words, 
this computer cannot be both a Bluetooth Network Access server and a Bluetooth 
Network Access client at the same time. 
6.6.8.1 Setup for Windows 98SE & Windows Me 
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NOTE: Internet Protocol routing software is required on Windows 98SE and Windows 
Me servers. Install and configure the routing software as instructed by the software's 
manufacturer before you configure the computer as a Network Access server. 
Configure the server: 

1. From the Windows Control Panel, double-click the Network icon. 
2. On the Configuration tab, select TCP/IP-> Bluetooth LAN Access Server Driver 
(scroll down if necessary). 
3. Click Properties and select the IP Address tab. 

a) Select Specify an IP address 
b) Enter an IP Address (suggested value—192.168.1.1) 
c) Enter a Subnet Mask (suggested value—255.255.255.0) 

4. Click OK to close each dialog box, and then click YES to restart the computer. 
6.6.8.2 Setup for Windows 2000 and Windows XP 
If Internet Connection sharing was previously enabled (before BTW was installed) it 
must be disabled and then re-enabled before the Bluetooth network adapter can use it. 
Configure for Network Access: 

1. From the Windows system tray, right-click the Bluetooth icon and select Ad-
vanced Configuration from the shortcut menu. 
2. In the Bluetooth configuration panel, select the Local Services tab, Network Ac-
cess and then click Properties.... 
3. From the Network Access, General properties page, in the Type of service 
shortcut menu, select “Allow other devices to access the Internet/LAN via this 
computer,” and then click Configure Connection Sharing. 
4. Right-click Local Area Connection, select Properties and then select the Sharing 
tab. 
5. Select Enable Internet Connection Sharing for this connection, click OK, and 
then click YES in the confirmation dialog box. 

6.6.8.3 Configure for Group Ad Hoc Networking: 
1. From the Windows system tray, right-click the Bluetooth icon and select Ad-
vanced Configuration from the shortcut menu. 
2. In the Bluetooth configuration panel, select the Local Services tab, Network Ac-
cess and then click Properties.... 
3. From the Network Access, General properties page, in the Type of service 
shortcut menu, select “Allow other devices to create a private network with this 
computer.” 
4. Click OK. 

 

6.6.9 Bluetooth Image Transfer 
This service allows images to be exchanged between this computer and other Blue-
tooth devices that support Bluetooth image transfer. 
Supported image formats include: 

‧ BMP 
‧ GIF 
‧ PNG 
‧ JPG 

NOTE: A battery-powered remote device, such as a cell phone or camera, may re-
quire that Bluetooth be specifically enabled before the device can accept an image; 
see the documentation included with the device for more information. Some devices, 
particularly battery-powered devices such as phones and cameras, may only be able 
to accept images in one format and at a single fixed resolution. In that case, the image 
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is converted to the required format and resolution before it is transferred to the remote 
device. 
To transfer an image, choose one of the following methods: 

‧ Right-click an image or a selected group of images, select Send To, Bluetooth, 
and then select the Bluetooth device to which the image will be sent. 
‧ Drag-and-drop an image or a selected group of images onto the Bluetooth Im-
age Service icon of a remote device. 
‧ Copy an image or a selected group of images to the Windows clipboard, right-
click the remote device icon, and then, from the shortcut menu, select Paste. 

6.6.10 PIM Item Transfer 
Overview 
The PIM Item Transfer service allows Personal Information Manager items to be 
transferred between this computer and a remote Bluetooth device. 
Four data types are supported: 

‧ Business Cards 
‧ Calendar Items 
‧ Email Messages 
‧ Notes 

Each data type can be saved in any of the supported and installed PIMs. 
NOTE: PIMs that are not installed on this computer will not appear in the shortcut 
menus.  
 
When the PIM that is associated with an individual data type is changed on the PIM 
Item Transfer page, that data type is also changed for the PIM Synchronization ser-
vice. 
Configure 
In addition to the configuration options common to all Bluetooth services, this service 
also has settings that determine: 

‧ How business card requests are handled. The options are: 
Never send my business card—ignore the request 
Choose a business card as needed—when prompted, select a business card to 
be sent to the requester. 
Always send the same business card—when a request is received always send 
the same business card. When this option is selected, a dialog box prompts you 
to select an installed Personal Information Manager (if more than one is in-
stalled on this computer) and an existing business card. 
Previously sent business cards—once a card is selected using the “Always 
send the same business card” option, that card will be added to the shortcut 
menu as an option. 

NOTE: Previously sent business card additions to the menu are limited to ten, after 
which the oldest contact will be replaced. 

‧ Where to store inbound data items, on an individual basis. Options include (not 
all options apply to all items): 

Do Not Accept 
Any of the installed PIMs on this computer 
Save to Folder 

‧ The Bluetooth Exchange Folder location—the directory on this computer where 
inbound items that are not to be saved in a PIM will be kept. 
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NOTE: This is also the folder where the File Transfer service stores inbound items. 
If this folder is reconfigured here, it will also be reconfigured in that service auto-
matically. 
‧ Whether to send/receive attachments with email. 

Close a PIM Item Transfer connection 
PIM Item Transfer connections close automatically when the data transfer is complete. 
Default Business Card Selection 
When the “Always send the same business card” option is selected, a dialog box 
prompts you to select a default business card. 
The first time the dialog box is displayed it provides a way to choose the Personal 
Information Manager that stores the default business card. Click the down-arrow in 
the PIM shortcut menu and select the PIM to be used. 
On subsequent appearances of this dialog box, the PIM selection option is not avail-
able. 
Change the selected PIM 
On the PIM Item Transfer properties page, “Received items” section, there is a Busi-
ness Cards shortcut menu. When a PIM was selected during initial setup the selected 
item in this menu was set to the same PIM. To change the PIM used for the default 
business card, open this shortcut menu and select a new PIM. 
NOTE: A new default business card must be selected from the database of the newly 
selected PIM. 
Choose a default business card 

1. In the Select a Bluetooth Business Card dialog box that is displayed when “Al-
ways send the same business card” is selected, select the card. 
NOTE: If you mouse over a card that has been selected, a message is displayed 
with additional information about that contact. 
2. Click OK to choose a selected business card and return to the PIM Item Trans-
fer Properties page. The chosen contact is now displayed and selected in the 
“Business card requests” shortcut menu.  

If the “Always send the same business card” option is selected again, and a different 
contact is chosen, the properties page will display both contacts in the shortcut menu. 
NOTE: In addition to the default menu options, the shortcut menu can hold up to ten 
contact names. 
 

6.6.11 PIM Synchronization 
The PIM Synchronization service can be used by a remote device to synchronize its 
Personal Information Manager (PIM) database with the PIM database of this computer. 
Four data types are supported: 

‧ Business cards 
‧ Calendar items 
‧ Email messages 
‧ Notes. 

Whether an individual item is accepted and where it is stored, when accepted, is 
configured in the PIM Item Transfer service. If that service is not configured to store a 
particular data type in Outlook, then that data type cannot be synchronized. 
NOTE: Data types that will be synchronized must be saved in the PIM database (this 
is configured in the PIM Item Transfer service); otherwise, that data type will not be 
available for selection (it will be grayed out) in the PIM Synchronization configuration 
settings. 
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Microsoft Outlook permits duplicate entries, so all duplicates may not be exchanged in 
the synchronization process. 
NOTE: Only Outlook’s default contacts folder is synchronized. Items in sub-folders are 
not synchronized. Items that are moved from the default folder to a sub-folder will not 
be displayed the next time synchronization takes place. 

6.7 Hardware Settings 
The Hardware tab of the Bluetooth Configuration Panel provides basic information 
about the Bluetooth hardware installed on this computer and access to the Advanced 
Settings dialog box, if required: 

 
‧ Devices: 

Name: the name of the device, e.g., My Bluetooth Device 
Type: the type of device, e.g., USB. 

‧ Device Properties: 
Device status: indicates that the device is operating properly or that there is a 
problem/conflict. 
Manufacturer: the name of the company that manufactured the device selected 
in the Devices section of this dialog box. 
Firmware Revision: the manufacturer's firmware version number. 
Device Address: the Bluetooth Device Address (BDA or BD_Addr) assigned to 
this device when it was manufactured. 
HCI Version: the version number of the Bluetooth Specification that the Host 
Controller Interface complies with. 
HCI Revision: the revision number of the Bluetooth Specification that the Host 
Controller Interface complies with. 
LMP Version: the version number of the Bluetooth Specification that the Link 
Manager Protocol complies with. 
LMP Sub Version: the sub-version number of the Bluetooth Specification that 
the Link Manager Protocol complies with. 
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‧ Retest Button: Queries the hardware device selected in “Devices,” and up-
dates the data displayed in “Device Properties.” 

 

6.8 Accessibility Settings 
The Accessibility tab of the Bluetooth Configuration Panel lets you specify whether 
remote devices may access this computer, which remote devices have access, and 
whether an audio warning is played when a Personal Identification Number (PIN code) 
is required. 

 
Allow other devices to discover this computer 
Select “Let other Bluetooth devices discover this computer” to permit remote Bluetooth 
devices to find and report this computer. 
If “Allow No devices” (below) is selected, this option is not available. 
Control the types of devices that are allowed to connect to this computer 
From the “Devices allowed to connect to this computer” shortcut-menu, select: 

‧ No devices—no remote devices are permitted to initiate a connection with this 
computer. However, this computer can still initiate connections with remote Blue-
tooth devices. 
‧ All devices—all remote devices are permitted to connect to this computer. 
Connections are subject to additional security restrictions, such as authentication 
and authorization, which may be required by the individual services provided by 
this computer. 
‧ Only paired devices—only devices that have been paired with this computer 
are allowed to connect to it. 
‧ Only devices listed below—only the listed devices are allowed to connect to 
this computer (see Accessibility, adding and deleting devices). 

Choose an audio notification file 
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When Secure Connection is enabled for any of the Bluetooth Services on this com-
puter a PIN code is required before that service can be accessed. To chose a 
notification sound that will play when a remote device attempts to access a service 
that requires a secure connection, click Select audio file... and select the sound (*.wav) 
file to be played. 
Limit access to this computer to specific remote devices 
From the Bluetooth Configuration Panel, Accessibility tab, in the Allow shortcut menu, 
select “Only devices listed below”. 
Add a device to the list 

1. Click Add Device 
2. In the Devices with access... dialog box select the desired devices, and then 
click OK. 

NOTE: Multiple devices may be selected using SHIFT + click and/or CTRL + click. 

Delete a device from the list 
In the list of devices allowed to access this computer, select the device to be removed 
from the list, and then click Delete. 

6.9 Discovery Settings 
The settings on the Discovery tab of the Bluetooth Configuration Panel determine 
whether this computer looks for other Bluetooth devices automatically, how often it 
looks for devices, and what type of devices it looks for. 

 
Periodic Search for Devices 
When “Look for other Bluetooth devices” is selected, Bluetooth automatically searches 
for devices every X minutes. X is a whole number between 1 and 60. To change the 
time between automatic inquiries, highlight the existing time and enter the new time. 
NOTE: When My Bluetooth Places is first opened, it performs an initial automatic 
search for devices even if “Look for other Bluetooth devices” is not enabled. 
Determine the devices that will be reported 
Bluetooth can screen out devices that you do not need access to. 
The options are: 
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‧ Report all Bluetooth devices 
‧ Report only selected Bluetooth devices (see Discovery, Adding Specific Devices 
and Discovery, Deleting Specific Devices). 

Select the preferred option from the drop-down list. 
Discover Specific Devices 
The type of devices that this computer looks for and reports when it is searching for 
other Bluetooth devices can be limited. 
Limit the remote devices reported 
Bluetooth can report only specific devices, specific classes of device, or specific types 
of device within a class. 

‧ Specific devices: an individual computer or Bluetooth cellular telephone are ex-
amples of specific devices. 
‧ Specific class of device: “computer” is an example of a class of devices 
‧ Specific type of device within a class: “laptop” is an example of a specific type of 
device within the “computer” class of devices. 

The devices to be discovered can be mixed and matched; you can discover one or 
more specific devices, classes of devices and types of devices within a class at the 
same time. 
Remove a device from the list of devices to be discovered 
In the Bluetooth Configuration Panel, from the Discovery tab, select the device to be 
removed and click the Delete button. 
NOTE: If “Report only selected Bluetooth devices” is not selected, the Delete button 
will not be available. 
Temporarily override the discovery of specific devices 
In the Bluetooth Configuration Panel, from the Discovery tab, select “Report all Blue-
tooth devices.” The specifically selected devices will be discovered along with all other 
devices. 
To re-enable specific device discovery re-select “Report only selected Bluetooth 
devices.” 
NOTE: When all devices are deleted, an error message will appear if “Report all 
Bluetooth devices” is not selected. 
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7 Chapter 7 
Security 
 

7.1 Authentication 
Authentication is used to verify identity; it requires a passkey or link key from the 
remote device. When a remote device attempts access, a visual and/or audio warning 
notifies the local operator. 
If the notification is ignored, access is denied after a preset timeout. 
When devices are “paired,” those devices automatically exchange a link key and 
Authentication is carried out without operator intervention. 

7.2 Authorization 
Authorization is Yes-or-No security that requires operator intervention to avoid having 
the connection time out and fail. Authorization is enabled automatically when Secure 
Connection is enabled, but it can be turned off on a service-by-service basis for each 
remote device. 
Authorization is limited to: 

‧ Yes, you may connect (click the balloon to proceed) 
‧ No, you may not connect (ignore the balloon prompt and the connection will fail). 

7.3 Bluetooth Device Identity 
Every Bluetooth device has a unique Bluetooth Device Address (BDA) assigned to it 
during the manufacturing process. This address cannot be changed. 
The BDA is usually displayed in hexadecimal format; 00:30:4F:03:2E:9F is a valid 
BDA. 
Each Bluetooth device also has a configurable, user-friendly name to help distinguish 
it from other devices. The user-friendly name may be up to 99 alphanumeric charac-
ters in length and may contain spaces. My Personal Computer is a valid user-friendly 
name. 

7.4 Encryption 
Encrypting data translates it into an unreadable format using a secret key or password.  
Decrypting the data requires the same key or password that was used to encrypt it. 

7.5 Link Key 
A link key is a unique, internally generated, access code based on a passkey, the 
Bluetooth Device Address and an internally generated random number. Link keys are 
generated automatically when devices are paired. 
After a link key is generated, manual entry of the passkey is not required. 
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7.6 Pairing Devices 
Pairing allows you to avoid entering access information each time a connection is 
attempted. Paired devices share a unique link key, which they exchange each time 
they connect. 
NOTE: The mate of a pair is always displayed in My Bluetooth Places, even if the 
mate is not turned on or is out of connection range. 
Paired devices remain paired even when 

‧ One of the devices is not on 
‧ A service connection is interrupted or the service stopped 
‧ One or both devices are rebooted. 

To Pair with another device 
If Secure Connection is enabled, devices will pair automatically the first time they 
connect (a passkey must be successfully exchanged). 
To pair with a device manually: 
In the Folders pane of My Bluetooth Places, right-click a device, select Pair Device 
from the shortcut menu, and then follow the on-screen instructions. 
To Remove Pairing 
In the Folders pane of My Bluetooth Places, right-click a paired device and select 
Unpair Device from the shortcut menu. 

7.7 Passkey 
An alphanumeric string up to 16 characters in length. Passkeys are also called Per-
sonal Identification Numbers, or PIN codes. 
A passkey may be required if the Secure Connection option is enabled for a Bluetooth 
service or application. 

7.8 Secure Connection 
A passkey or link key is required each time a connection is attempted. 
All data exchanged over the Bluetooth connection is encrypted. 
Authorization is also enabled by default when Secure Connection is enabled but 
Authorization can be disabled on a service-by-service basis for each remote device 
that is permitted to connect to this computer. 

7.8 Security Request Dialog Box 
A Bluetooth passkey request and/or Bluetooth Authorization request balloon may 
appear over the Windows system tray when a connection is attempted if Secure 
Connection is enabled. 
Click the balloon to proceed. 
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A Appendix A 
Trouble Shooting 
 

Q1: CANNOT CONNECT TO A PAIRED DEVICE: 

A1: Paired devices are always displayed in My Bluetooth Places, even if the remote 
device is out of range or not powered up. 

Verify that the remote member of the pair is within radio range and powered up and 
then attempt the connection again. 

Q2: CANNOT DISCOVER SERVICES ON AN UN-PAIRED REMOTE DEVICE: 

A2: The remote device may not be powered up or may be out of range. 

 Verify that the remote device is powered up. 

 Verify that the remote device is in Connectable mode (Bluetooth Configuration 
Panel > Accessibility tab). 

 Perform a Search for Devices to verify that the device is within range. 

Q3: DIAL-UP NETWORKING SERVICE DOES NOT START: 

A3: The Dial-up Networking service will not start unless a properly configured modem 
is attached to the server. 

 Verify that the modem is usable as a local device from the server. 

 In the Bluetooth Configuration Panel, Local Services tab, double-click the Dialup 
Networking service: 

 Click the down arrow in the Modem field and select the modem that will be 
used to dial out. 

 Click the OK button. 

 Click the OK button to close the Bluetooth Configuration Panel. 

Q4: HOW DO I DETERMINE THE BLUETOOTH DEVICE ADDRESS (BDA) OF MY 
HARDWARE DEVICE? 

A4: In the Bluetooth Configuration Panel, on the Hardware tab, in the Devices section, 
select the device you want to determine the address of. In the Device Properties 
section of the dialog box, the fourth entry, Device Address, is the BDA of the selected 
Bluetooth. 

Q5: HOW DO I DETERMINE THE VERSION NUMBER OF THE BLUETOOTH 
SPECIFICATION THAT THE HOST CONTROLLER INTERFACE (HCI) COMPLIES 
WITH? 

A5: In the Bluetooth Configuration Panel, on the Hardware tab, in the Device Proper-
ties section, the fifth entry provides Bluetooth Specification compliance information for 
the Host Controller Interface. 

The sixth entry contains the Specification Revision information for the Host Controller 
Interface, if appropriate. 
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Q6: HOW DO I DETERMINE THE VERSION NUMBER OF THE LINK MANAGER 
PROTOCOL (LMP)? 

A6: In the Bluetooth Configuration Panel, on the Hardware tab, in the Device Proper-
ties section, the seventh entry provides Link Manager Protocol version number 
information. 

The eighth entry contains the Link Manager Protocol sub-version number information, 
if appropriate. 

Q7: HOW DO I FIND INFORMATION ABOUT THE BLUETOOTH HARDWARE 
ATTACHED TO MY COMPUTER? 

A7: In the Bluetooth Configuration Panel, select the Hardware tab 

Q8: INTERNET CONNECTION SHARING DOES NOT WORK: 

A8: This occurs because Internet Connection Sharing was enabled when Bluetooth 
was installed (this is a Microsoft Windows behavior and is considered proper opera-
tion). 

To enable Internet Connection Sharing: 

1. Disable Sharing for the Ethernet adapter: 

a) Windows Control Panel > Network and Dial-up Connections 

b) Right-click “Local Area Connection,” select Properties, and then select the 
Sharing tab. 

c) Clear the check box for “Enable Internet Connection Sharing for this connec-
tion,” and then click OK. 

2. Re-enable Sharing for the Ethernet adapter; repeat Step 1.c.), and select (check) 
the sharing box. 

If you are prompted to select an adapter, select “Bluetooth network adapter.” (This 
option is not displayed unless more than one adapter is available.) 

If asked to restart the computer, do so. 

Q9: HOW DO I TEST A NETWORK ACCESS CONNECTION? 

A9: If the client is hardwired to the LAN, unplug the hardwired connection to ensure 
that the test checks the wireless connection rather than the hardwired connection. 

If the server has access to the Internet, open a browser on the client and connect to 
the World Wide Web. 

You may also Ping the server from the DOS prompt. 

Q10: WHY DO I GET AN UNKNOWN PORT MESSAGE WHEN I ATTEMPT TO USE 
A BLUETOOTH SERIAL PORT? 

A10: The “Unknown Port” error message usually means an attempt was made to 
connect a port that was in use. 

Additional Bluetooth Serial Ports can be added if they are required. 

Q11: BLUETOOTH HEADSET DOES NOT ALWAYS FUNCTION UNDER WIN98: 

A11: Windows 98 cannot convert audio files with the extension m3u (e.g., myfile.m3u) 
into the Pulse Code Modulation (PCM) audio format used by Bluetooth headsets; this 
is a limitation of Windows 98. 
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Other versions of Windows (2000, ME and XP) can translate m3u audio files into the 
PCM format. 

Possible solutions are: 

‧ Upgrade to a newer version of Windows 

‧ Use an m3u-to-mp3 conversion utility to convert the file(s) into a format that is 
supported by Windows 98. (Conversion utilities are available as freeware or share-
ware on the Internet.) 
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B Appendix B 

Specification 
 

Model BT-410U BT-420U 

Bluetooth Spec. 
Compliance Bluetooth V2.0+EDR 

Transfer rates 
(Max) Max UART baud rates of 3Mbps 

Operating Voltage +5V 

USB Standard USB 2.0 

Operating Distance 100 m in free space 10 m in free space 

Antenna 2dBi PCB Antenna 0 dBi printing Antenna 

Dimension 49.36 (L) x 17.99(W) x 7.55(H) mm  

Power Consump-
tion 

TX  120mA 

RX  58mA 

Stand By  50mA 

TX  60mA 

RX  58mA 

Stand By  30mA 

Environment  

Operation temperature: 0 ~ 60 Degree C  

Storage temperature: -10 ~ 70 Degree C 

Humidity: 5 ~ 90% non-condensing 

Radio 

Spread Spectrum Frequency Hopping Spread Spectrum (FHSS) 

Frequency Range 2402~2483.5MHz 

RF Channels 79 

Polarization Omni-directional  

Modulation GFSK for 1Mbps, π/4-DQPSK for 2Mbps, 8-DPSK for 
3Mbps  

Output Power 13.35dBm  1.74dBm  

Receiver Sensitiv-
ity <-82dBm at < 0.1% BER  <-82dBm at < 0.1% BER  

Base Band 

Support of ACL link with data rate up to 3Mbps 
Physical Links 

Support of SCO link 

Network Capabili-
ties 

Support of piconet point-to-point and point-to-multipoint 
connections 
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